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RELEASE NOTES

Version Date Notes
2.25 Feb. 09, 2010 » Modified: Appendix IV — Reader Settings Table
2.24 Feb. 08, 2010 » New: 2.1.4 Code ID
» Modified: 2.3.1 Input — add Check Code Length
» Modified: Chapter 3 Barcode screenshot updated
» Modified: Appendix I — support ISBT 128 for CCD/Laser
> Modified: Appendix II — support ISBT 128 for CCD/Laser
» Modified: Appendix II — support UPC-E1 for CCD/Laser
> New: Appendix II — Code ID Table
» New: Appendix III — Code ID Table
» New: Appendix IV — Code ID Table
2.23 Nov. 24, 2009 » New: support 8400-2D
» Modified: 3.4.2 WEP Key — change to ASCII input
» Modified: 3.4.3 WPA-PSK/WPA2-PSK Passphrase — change to
ASCII input
» Modified: Appendix IV — Chinese 25, Matrix 25, Picklist Mode, 1D
Inverse, 2D Inverse, UPU FICS Postal and USPS 4CB/One Code/
Intelligent Mail
2.22 July 08, 2009 » New: support 8400
> New: Features — support quick download by saving download
properties to an initial file
> Modified: Utilities Menu — remove “RF”
» Modified: 1.5 Download & Baud Rate — remove “RF”
» Modified: 2.3.2 Scanner — remove
> Modified: 2.5.1 Buzzer Test
> Modified: 4.7.2 Keypad Type - add 8300 Keypad Type
» Modified: 3.4.3 WPA Passphrase — supports WPA2-PSK for 8400
> Modified: remove Bluetooth-related descriptions (3560 phased
out)
2.21 Mar. 03, 2009 » Modified: 4.2.3 Horizontal Steps — FN key combination on 8000

Modified: 4.6 Lock Screen — FN key combination on 8000

Modified: Appendixes I~III — GS1-128 (EAN-128), GS1 DataBar
Omnidirectional (RSS-14), GS1 DataBar Limited (RSS Limited),
GS1 DataBar Expanded (RSS Expanded)



2.20 Jan. 16, 2009 Separate documentation of 5250 Emulator and VT Emulator

> Modified: System tab (1) remove Func Toggle to the Emulation
tab

> Modified: Wireless LAN tab (1) change WPA Passphrase from 8~64
to 8~63 hex values (2) Power Saving Mode (added)

» Modified: Emulation tab (1) add 8500 Keypad Type (2) support
8500 44-TE Key

» New: GPRS tab for 8500 only
2.10 July 17, 2008 New Word template applied
» New: 2.6 Hardware Test for buzzer and barcode reader

> Modified: Appendix II - support “Field Separator” setting for
EAN-128 with CCD/Laser scan engine

2.00 Oct. 02, 2007 New Word template applied
» Merge documentation of 5250 Emulator and VT Emulator
1.11 June 12, 2006 Company name changed to CIPHERLAB CO., LTD. since April 2006

» Modified: Modified for 8061/8071/8360/8370/8500
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INTRODUCTION

Seeing the need to combine wireless connectivity and telnet terminal emulation, MIRROR
5250 Emulator, also known as CipherNet-5250, is designed to provide telnet terminal
emulation on the 8000/8300/8400/8500 Series Mobile Computers, which are capable of
802.11b/g or GPRS connectivity.

The software, consisting of CipherNet programs (.exe) and the associated runtime (.shx),
is designed for the users to develop custom telnet sessions for the use with the terminal
emulation runtime preloaded on the mobile computers, without spending time writing
any program code. Each of the mobile computers is a telnet client that allows the user to
connect to a host computer, such as an IBM AS/400 server that supports 5250
emulation, and make use of the applications running on it. Thus, the mobile computer
works as an input device to a host computer, and the data collected or input will be sent
back to the host computer. On the other hand, the mobile computer works as an output
device as well because it can display data coming in from the host. Based on the nature
that the screen size of the mobile computer is smaller than that of an actual terminal,
CipherNet programs provide a number of unique features for reformatting host screens.

This manual serves to provide comprehensive understanding of MIRROR 5250 Emulator,
and helps start a telnet session running host applications. We recommend that you read
the document thoroughly before use and keep it at hand for quick reference.

Thank you for choosing CipherLab products!
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FEATURES

v

v Vv VvV VvV VvV VvV VvV v v

CipherNet-5250 supports 5250 terminal emulation

Can automatically insert data into an input field in the host application via reading
barcodes or RFID tags

Easy cloning by saving user settings to a configuration file (.NET)

Supports auto sign on, cursor tracking, etc.

Supports key mapping

Supports control for barcode reader as well as RFID reader

Supports control for beeper and vibrator

Provides font size options

Supports multiple languages

Supports host screen capture and reformatting (Activation key is required!)
Supports quick download by saving download properties to an initial file
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GETTING STARTED

I) Run CipherNet-5250.exe from the Product CD.
2) Click OK to accept the End-User License Agreement (EULA).

3) Download the runtime program (.SHX) to the mobile computer via Utilities Menu |
Download Program.

Associated Runtime Programs

80xx-5250.SHX
83xx-5250.SHX
84xx-TN-*.,SHX
85xx-5250.SHX

(Download this program file to 8071.)

(Download this program file to 8330 or 8370.)

(Download this program file to 8400 or 8470.)

(Download this program file to 8500, 8570, 8580 or 8590.)

On the mobile computer, press 7, 9 and Power simultaneously to enter System
Menu | Load Program.

4) Click the drop-down menu of

Select Product j

and select the mobile computer you

are working on. l

% Cipherliet Terminal Emulation For 5250 =10 x|
File Utlites Telnet Help l

0| & =6 &)@ » || =] [s500 ~

E

E- Information

- Terminal Model : CipherLab 8500
- ¥Wersion : ¥3.00.2
- Copyright[c] 2004-2009, CIPHERLAB CO., LTD.

- System

- Power On : Hesume Program
- Auto Power Off : 180 seconds
--Backlight : Turn Off

- Turn off if idle for 20 seconds
- Download via : Cradle-IR

- Baud Rate : 115200 bps

- Key Click : Enable

- Function Key : Unlocked

- Security

E

/- Prompts and Messages

r- Barcode

v Wireless LAN
r- Emulation

- Screen accordingly.

B

- GPRS

The associated information and default settings
of the target mobile computer will be displayed

5) Configure the current user settings via Utilities Menu | Configure.
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6)
7)

8)

When you are editing an existing or new configuration file, the information and
settings above will be updated accordingly.

Save the current user settings to a configuration file via File Menu | Save.

Download the configuration file (.NET) to the mobile computer via Utilities Menu |
Download Settings.

From the CipherNet Runtime Menu on the mobile computer, select 2. Utilities
Menu | 8. Download.

From the CipherNet Runtime Menu on the mobile computer, select 1. Telnet to
start a fresh new telnet session after downloading.

The mobile computer will be associated with an access point and connected to a host.
During the telnet session, you will be able to make use of the host applications after
login. To exit the telnet session, press ESC and FN simultaneously after logging out
properly.

» Understanding the Status Icons

On the terminal screen, a number of status icons will be displayed on the bottom

line.

Icon Remark

Special Key For 8500 Series, individual icons for Shift, Alt and FN indicate a
specific key is pressed.

Navigator A graphic icon to indicate the relationship between the terminal
screen and the host screen. Refer to 4 Emulation Settings.

Lock A lock icon indicates that you have pressed a function key that is not
allowed. The message “Function key not allowed.” is displayed on the
terminal screen.

» Press ESC to unlock it. The icon will become an empty box.

Reader Refer to 2.1 Barcode Reader.

» An empty box indicates both readers are disabled.
» A barcode icon indicates only the barcode is enabled.
» A cross-out barcode icon indicates both the barcode and RFID
readers are enabled.
» A flash icon indicates only the RFID reader is enabled.
Antenna An antenna icon indicates the RF signal strength.
Battery A battery icon indicates the battery strength.
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WORKING WITH MENUS & TOOLBAR

The menu bar contains a number of menus that specify which task you want the system
to perform. Each menu contains a list of commands.

FILE MENU
% Cipherllet Terminal Emulation For 5250 - 10| x|
File Utilities Telnet Help
BECTIEEENN| 4| ] m | [8500 ~|
Open... Ctrl+0
Save Ctrl+5
Save As...
Exit Alt+F4
Command Action...
New To create a new configuration file for the telnet client. Refer to each chapter.
Open To open an existing configuration file. File path needs to be specified.
Save To save the current settings to a configuration file (.NET).
Save As To save the current settings to a new file.
Exit To close the application.
UTILITIES MENU

= Cipherliet Terminal Emulation For 5250 - | EI|£|

File | Utlities Telnet Help

M! | (8500 -
Download settings... Ctrl+D [ﬁ I J

Download Program.., Cirl+P

Command Action...

Configure To configure the current user settings. Refer to each chapter.

»
»
»
4
»
4

Download To

System Settings
Barcode Settings
Wireless LAN Settings
Emulation Settings
Screen Settings
GPRS Settings

download the current configuration file (.NET) to the target mobile

Settings computer.

»

If "Download via USB VCOM" is selected, skip baud rate settings.
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Download
Program

TELNET MENU

= Cipherliet Terminal Emulation For 5250

File Utilities | Telnet Help
0 || i I (| = | [s500 ~|

» The download properties will be saved to an initial file automatically. As
long as the settings are correct, the Download Properties dialog box will not
appear.

To download the runtime program (.SHX) to the target mobile computer.

» For language setting other than “single byte character” in CipherNet-5250,
download the font file for the selected language.

=10l x|

[Discanmect

" Informa

__ System Start Capbure..,.

- Barcode ;:pt"('__re t

- Wireles SR SR
Command Action...
Connect To connect to a host.

> Click “Save Log” if necessary.

Disconnect To disconnect with the host.

Start Capture
Capture
Stop Capture

HELP MENU

% Cipheriet Terminal Emulation For 5250

File Utilities

Telnet

To start the Capture task with a file (.SCR) for saving host session screens.
To capture the current host session screen.

To stop the Capture task and close the .SCR file.

=10l x|

Help

0[] 5| IR | [es00 -]

=l Information
-~ Terminal Model : CipherLab 8500
- ¥Yersion : ¥3.00.2

Command

Action...

About CipherNet

To show version information about CipherNet and End-User License Agreement.

» Version information is also available from the tree view.
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TOOLBAR

The toolbar allows quick access to commands that are available in the current stage.

0| & =8| &)@ » | =] [s500 ]

From left to right, they stand for the following commands:

File Menu | New

File Menu | Open

File Menu | Save

Utilities Menu | Configure

Utilities Menu | Download Settings
Telnet Menu | Connect

Telnet Menu | Disconnect

Telnet Menu | Start Capture
Telnet Menu | Capture

Telnet Menu | Stop Capture

A=

Select Product j Select Product
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Chapter 1
SYSTEM SETTINGS

On this property page, system settings of the mobile computer can be changed.

System | Barcode | Wireless LAN | Emuiation | Screen | GPRS |
Onwer - Change Prompts and Messages : IMain Menu (1572) j
* Resume Program 4
= Restart Program . Telnst |1_ Telnet
Puto Power Cff : IF seconds 2. Ltiltiss |2_ Lhilties

Qe |

Password (1 ™ 8 digits) : I

[~ TCP /IP Settings

[T Set Date & Time

|
|
[~ Emulation Settings |
|
|

[~ Lkility Menu

@adﬁlight
* Tum Off

\ 5 'Jc'.mlnad via : I.:m,ﬂe_m vI Baud Rate : |1152|}[:- bps Vl
£ Tum On upon power up

Tumoff fidefor [2 (179" 10sec (6 F Key Click (T)Hesa |

ok | cance |

Once the configuration file (.NET) has been downloaded to the mobile computer, the new
settings will take effect immediately and become the defaults. However, you still can
change many of the settings directly on the mobile computer via CipherNet Runtime
Menu or System Menu:

CipherNet Runtime Menu — Press the Power key on the mobile computer.

Backlight CipherNet Runtime Menu | 2. Utilities | 4. Backlight
Baud Rate CipherNet Runtime Menu | 2. Utilities | 7. Baud Rate
Download via CipherNet Runtime Menu | 2. Utilities | 8. Download
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System Menu — Press 7, 9 and the Power key simultaneously on the mobile computer.

Backlight (Period) System Menu | 2. Settings | 2. Backlight Period
Power On System Menu | 2. Settings | 3. Auto Off
System Menu | 2. Settings | 4. Power On Options

Key Click System Menu | 2. Settings | 5. Key Click

IN THIS CHAPTER

3 A = 1117 o o P 10

1.2 SCUNY ittt e 10

1.3 Backlight ... 11

1.4 Change Prompts & MESSagesS .....covviiiiiiiiiiiiiiiiiiiieeans 11

1.5 Download & Baud Rate .......cocovviiiiiiiiii e 12

1.6 Key CliCK curiiiiiiii i s eennes 12

3 == < PP 12

1.1 POWER ON

1.1.1 RESUME PROGRAM

By default, the mobile computer will start from the latest telnet session at the time it is
turned off.

1.1.2 RESTART PROGRAM

If selected, the mobile computer will start from the CipherNet Runtime Menu.

1.1.3 AUTO POWER OFF

By default, the mobile computer will be automatically turned off when no operation is
taking place within 180 seconds.

1.2 SECURITY

For security concerns, you may specify a password and select the check box of one or
more tasks that need security checking. By default, no password is required for any task.
If any task is selected and provided with a password, you will not be allowed to enter an
associated menu on the mobile computer without the password. This can prevent
unauthorized users from changing the application settings.

» A password can be up to 8 alphanumeric characters.

Note: The password is case-sensitive.

10
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Security Option Remark

TCP / IP Settings If selected and provided with a password, you will not be allowed to
enter the following menu on the mobile computer unless the correct
password is entered:

CipherNet Runtime Menu | 2. Utilities | 1. TCP/IP Settings

Emulation Settings If selected and provided with a password, you will not be allowed to
enter the following menu on the mobile computer unless the correct
password is entered:

CipherNet Runtime Menu | 2. Utilities | 2. Emulation Settings

Set Date & Time If selected and provided with a password, you will not be allowed to
enter the following menu on the mobile computer unless the correct
password is entered:

CipherNet Runtime Menu | 2. Utilities | 6. Set Date & Time

Utilities Menu If selected and provided with a password, you will not be allowed to
enter the following menu on the mobile computer unless the correct
password is entered:

CipherNet Runtime Menu | 2. Utilities

1.3 BACKLIGHT

By default, the backlight for the LCD and the keypad of the mobile computer is turned
off.

» When the backlight is turned on, you may specify a period of idle time so that it can
be automatically turned off. Such time-out is specified in the range of 1~9, in units of
10 seconds. The default time-out is 20 seconds.

1.4 CHANGE PROMPTS & MESSAGES

Re-define the prompts and messages, if necessary. If you want to customize the client
application to your local language, you must translate the text of the menus and
messages for the runtime into your own language.

) Download the font file (.SHX) for the selected language to the mobile computer via
Utilities Menu | Download Program.

On the mobile computer, press 7, 9 and Power simultaneously to enter System
Menu | Load Program.

2) Click the drop-down menu to select among the groups of prompts and messages.
Modify them within a maximum length of 15 or 20 characters, depending on the
screen size; otherwise, they will be automatically truncated.

3) Save the current user settings to a configuration file via File Menu | Save.

4) Download the configuration file (.NET) to the mobile computer via Utilities Menu |
Download Settings.

From the CipherNet Runtime Menu on the mobile computer, select 2. Utilities | 8.
Download.

11
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Note: For CipherNet-5250, you must download the font file for the selected language to
the mobile computer so that it can display the prompts and messages correctly.

1.5 DOWNLOAD & BAUD RATE

Click the drop-down menu to select a desired communications setting for the mobile
computer to download the runtime and configuration file (*.NET).

Download Option Remark

Download via 8000/8300/8500: If USB-VCOM is selected, it is not necessary to configure the
Baud Rate settings.

Cradle- 1R k

RS5-232 )
IrDA

|ISB-VCOM

Baud Rate By default, the baud rate setting is 115200 bps. However, it

57500 bps will be ignored by USB-VCOM.

9600 bps
1.6 KEY CLICK

By default, the mobile computer will produce an audible signal when you press any key
on the keypad, except for the SCAN key. Cancel the check box if such feedback is not
desired.

1.7 RESET

Click Reset to load the default settings.

Note: The current system settings will be cleared.
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Chapter 2
BARCODE SETTINGS

According to the requirements of a specific application, you may enable or disable any of
the barcode symbologies and configure its associated parameters.

Supported barcodes depend on the scan engine integrated on the mobile computer.

% Settings e |
System  Barcode | Wiireless LAN | Emulation | Sereen | GPRS |
Reader Type — Reader Settings
©5elect the reader type : Scan mode ILaser vl
) Laser/CCD Reade Read redundancy : m Reset to default
[ 2 ' RFID Settings | Time out : |3 SEC Sjrmirg Euration ; IE IEE
CodelD |
— Barcode Parameters
[¥ Code 35 mare. . [+ UPC-E mare... [T Telepen more...
[T tdlian Phamacods mare... [~ UPC-E Addon 2 [~ GS1 DataBar-14 MMore. .
[~ French Phamacode  more... [~ UPC-E Addon 5 [T G51 DataBar Limited ~ more...
¥ Industrial 25 mare... [+ EAMS mare... [T G51DataBar Eqpand  more...
¥ Intedeaved 25 mare... [T EANS Addon 2 [ Code 393
[~ Matrix 25 mare... [ EAMZ Addon 5 [¥ Code 128
[+ Codabar mare... [# EAN13 & UPCA Mmare. . [¥ GS1-128 (EAN128) Mmore. .
I~ msi mare... [ EAN13 Addon 2 [~ Megative Barcode
[~ Plessey mare... [ EAM13 Addon 5 v ISBT 128
QK I Cancel
IN THIS CHAPTER
2.1 Barcode REAEr .....iivi i 14
2.2 RFID REAAEN .iuiiiiiiie it e aaerea e 15
2.3 Advanced Settings ...oovvviiiiiii i 17
2.4 RS .t 19
2.5 Hardware TeSt...iiii i i aee e 20
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2.1 BARCODE READER

2.1.1 SELECT READER TYPE

Select a reader type that matches the hardware configuration of your mobile computer.
The associated barcode reader settings, as well as the barcode parameters (= symbology
settings) will be displayed accordingly.

— Reader Type
Select the reader type :

10 Laser/CCD Reader -

10 Laser/CCD Reader
20 Reader
10 Long Range Laser

For more information, refer to the following appendixes:

» Appendix I - Scan Engine Settings for information on the symbologies and RFID tags
supported.

» Appendix II - CCD/Laser Scan Engine provides information on the reader settings as
well as symbology settings for the CCD or Laser scan engine.

» Appendix IIT - LR/ELR Laser Scan Engine provides information on the reader settings
as well as symbology settings for the Long Range Laser or Extra Long Range Laser
scan engine.

» Appendix IV - 2D Scan Engine provides information on the reader settings as well as
symbology settings for the 2D scan engine.

Note: If you accidentally selected the wrong reader type and downloaded the settings to
the mobile computer, the mobile computer will use the defaults for the correct
reader type instead.

2.1.2 CONFIGURE READER SETTINGS

Depending on the barcode reader selected, configure the associated reader settings.
Refer to the Reader Settings Table in Appendixes II ~ IV.

2.1.3 CONFIGURE SYMBOLOGY SETTINGS

Depending on the barcode reader selected, configure the associated symbologies. Refer
to the Symbology Settings Table in Appendixes II ~ IV. For a symbology along with the

maore.

button _ 1, it means advanced symbology settings are available.
2.1.4 CODEID

Depending on the barcode reader selected, configure Code ID settings. Refer to the Code
ID Table in Appendixes II ~ IV.

14



Chapter 2 Barcode Settings

2.2 RFID READER

By default, the RFID reader is enabled to read UID only. Click the button

RFID Sedti . . .
e | to configure the associated settings.

[N x|

—Data — Warking Mode
¥ Read UID € Teggle
% Hybrid
[ Read Data

Il
Start B & Alwayz Ensble
Max Len |1 28 £ By 5250 Cammatd

[T Use Delimiter
I— Smitchiiey IDisaI:uIe *I

Delay before Rersad(0.1s) _ﬁﬂf'rqlﬂg Mode
rigger

I‘ﬂf ¥ Continous
cows|

2.2.1 DATA

Read UID
By default, the RFID reader is set to read tag UID (Unique Identification).

» UID: a permanent factory programmed unique identification (UID) code which is unique to
each tag.

Read Data
Select the check box so that RFID data can be read.

» If only partial data is required, specify the start position and maximum length.

Use Delimiter

Select the check box and specify a delimiter to separate UID from data when both are read.

» Click the editing box and select one character from the Grid Control (ASCII codes).

Delay before Re-read

By default, the RFID reader is set to re-read the same tag by an interval of 0.4 second when the
tag is not removed out of range.

» You may specify a delay time before re-read in the range of 1~9999, in units of 100
milliseconds.

15
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2.2.2 WORKING MODE
Toggle
In this mode, only one reader can work at a time: either RFID or barcode reader.
Control Options Working with the Switch Key
Always Enabled The RFID reader is enabled after login; however, it will not work

until you press the switch key.
To stop it from working, press the switch key again.

By 5250 Command The RFID reader is disabled after login. It will not work until you
send the 5250 command to activate it and then press the switch
key. To stop it from working, press the switch key again.

Hybrid (=dual mode)

By default, the RFID reader is always enabled and co-exists with the barcode reader, which is also
called “dual mode” because both readers can work at the same time.

2.2.3 CONTROL
If Toggle is selected, you must select a switch key from the drop-down menu.

Always Enable

By default, the RFID reader is always enabled after login.

By 5250 Command

If selected, the RFID reader is disabled after login. You must send the 5250 command to enable it.

Switch Key

The switch key works as the toggle of readers. When you press it on the mobile computer, only
one reader is allowed to work at a time.

» By default, the switch key is disabled.

> Select the switch key (FN+0 ~ FN+9). The selected combination will become unavailable on
the Function Key Mapping list. For example, if you select FN+5, you will find the key
combination mapped to “SwitchKey” in the Function Key Mapping on the Emulation tab.

2.2.4 READING MODE

Trigger

If selected, you may press the trigger to start each RFID reading.

» When working mode is set “Hybrid”, you can press the trigger to read an RFID tag or a
barcode label depending on which one first comes in range.

Continuous

By default, the RFID reader works in a continuous way. It will keep on reading the same RFID tag
until the tag is removed out of range.
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2.3 ADVANCED SETTINGS

These settings are provided to enhance the read operation via the barcode reader.

xq
— Input —Data
[~ Check Leading Code | I~ Add Prefic Code |
[ Check Code Length |15 = ™ Add Suffix Code |
Read Partial Code Beeper Sequence 0E 05
-
Start Position - = Good Read Notification
tart Position : I-I _|j Vibrator time(D. 15) I[;.
Madmum Length : 50 x
=l Lot Field Suffic | Undefined =]
Alarm Other Field Suffix |Llndefined v

Beeper Sequence |1 E 07 00 05
Vibrator time{(. 1s) I[:l QK Cancel

2.3.1INPUT

Check Leading Code

The leading code refers to the digit in the start position of a barcode. Select the check box to
verify the barcode input. When the leading code is found mismatching, the barcode will be
discarded.

Below are some examples.

Leading code Barcode scanned Transaction record
9 9876543210 9876543210
2 9876543210 (Discarded: code not matching)

Read partial code + Check leading code:

Start position Max. length Leading Code Barcode scanned Transaction record
2 7 8 9876543210 8765432
2 7 9 987654321 (Discarded)
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Check Code Length

By default, the maximum barcode length is 15. Select the check box so that it will perform a
length check on the barcode according to the length setting. When the barcode is found longer
than the specified length, it will be discarded.

Read Partial Barcode

By default, it will return the whole barcode that has been decoded. Select the check box so that it
will return partial barcode according to the settings of the start position and maximum length.

Below are some examples.

Start position Max. length Barcode scanned Transaction record
2 10 9876543210 876543210
2 3 9876543210 876

2.3.2 DATA

Add Prefix Code

Select the check box to prefix a code to the input data. Click the editing box next to it, and select
one or more codes from the Grid Control (ASCII codes). For example, you may add a dollar sign
“$"” to the front of the input data for price information.

Add Suffix Code

Select the check box to suffix a code to the input data. Click the editing box next to it, and select
one or more codes from the Grid Control (ASCII codes).

Note: You may use prefix/suffix code to wrap the input data.

Last Field Suffix

Select from the drop-down list to suffix a code to the last input field only. For example, you may
use this setting to automatically add "ENTER” to the last field.

Other Field Suffix

Select from the drop-down list to suffix a code to the input fields except the last one. For example,
you may use this setting to automatically add “"NEXT"” to the rest fields so that each can advance
to a next field.

2.3.3 GOOD READ (GOOD FEEDBACK)

When data is successfully read, the mobile computer may inform you by issuing a beep
or vibrating.

Beep Sequence

A beep sequence refers to pairs of Beep Frequency(x) and Beep Duration(y). You may specify
whether or not to have a beep when decoding of a barcode is done successfully.

» You may specify pairs of “x y” other than the default “0E 05”.
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Vibrator

Specify how long the vibrator is turned on (in units of 0.1 second) to indicate a barcode has been
read successfully.

» By default, the vibrator is turned off.

2.3.4 ALARM (ERROR FEEDBACK)

When an error occurs, the mobile computer may inform you by issuing a beep or
vibrating.

Beep Sequence

A beep sequence refers to pairs of Beep Frequency(x) and Beep Duration(y). You may specify
whether or not to have a warning beep to notify that an error occurs while reading a barcode.

» You may specify pairs of “x y” other than the default 12 07 00 05 1E 07".

Vibrator

Specify how long the vibrator is turned on (in units of 0.1 second) to notify that an error occurs
while reading a barcode.

» By default, the vibrator is turned off.

2.4 RESET

Click Reset to load the default settings. This applies to the following settings —

Reader Settings
Barcode & Parameters
Advanced Settings
RFID Settings

v v Vv Vv

Note: The current settings will be cleared.
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2.5 HARDWARE TEST

2.5.1 BUZZER TEST

You can test the buzzer by playing a beep sequence.

I) Turn on the mobile computer. The main menu created by the preloaded CipherNet
Runtime appears.

2) On the mobile computer, select 2. Utilities | 1. TCP / IP Settings.

LB il B R R

1l.Telnhet

2 Tiliti

_Subnet Mask
.Default Gateway
_.DDHCP &erwver
_BE5ID

.Terminal IP
.Ho=st IP or Name
_Telnet Port

_TCPFIP Sectings
_Emulation Settings
.RBeader Test
_Backlight *
.Battery Woltage

.Bet Date & Time
-Baud BRate
_Dowmload

1
2
3
4
5
&
2

00 - T O e Q0 M

3) In the submenu, press the following key combination to enter the buzzer test:
» F10 on 8400/8500
» FN+ 0 on 8000/8300

Take the 44-key 8500 mobile computer for example. You need to press FN to enable
the function key, and then press the key for red-coded F10.

4) Enter a desired beep sequence, and then press Enter to play it.
2.5.2 READER TEST

You can test the barcode reader by scanning barcode labels.

) Turn on the mobile computer. The main menu created by the preloaded CipherNet
Runtime appears.

2) On the mobile computer, select 2. Utilities | 3. Reader Test.
3) Start to scan barcode labels.

Along with the read data or error message on the terminal screen, there will be a
beep to indicate Good Read or Error.
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Chapter 3
WIRELESS LAN SETTINGS

To establish a telnet connection to a host, WLAN networking settings must be configured
correctly.

2l

1 JP {%
017 Enable DHCP Server (+ Open System (" Share Key
Subnet Mask : 255.255.128.0 ™ WEP  Keylength: |[64bis (Sbytes) ~| Active
Gateway : |152 168.1.250 Key 1- |EE 3000 0000 e
Lo I Key2 [0000000000 =
Teminal IP : |1§2.152 1.241
Key 3: |00 00 00 00 00 C
Local Name : |
: 0 00 00 00 00 c
SSID: [WiaN Keyd:  JORt
('2 )Hw [T WPA [~ WPA2  WPA Passphrase: |00 00 00 00 00 00
P . [132.188.1.1 -
Host IP or Name :  |192.168.1.100 ~| e i :Iip -'|—
Telnet Pott : |3 -

Keep Alive |'j (mintes)
(g,)mn Setting
[wr =]

Wireless Interface
™ Power Saving

Login Name : |n-ew Key: |Disable »
Login Password : Isruet*-t Key : |D|sahle 'I

™ Auto Sign On
OLE

OK Cancel
| | |

Once the configuration file (.NET) has been downloaded to the mobile computer, the new
settings will take effect immediately and become the defaults. However, you still can
change many of the settings directly on the mobile computer via CipherNet Runtime
Menu or System Menu:

CipherNet Runtime Menu — Press the Power key on the mobile computer.

1P CipherNet Runtime Menu | 2. Utilities | 1. TCP/IP Settings
Host CipherNet Runtime Menu | 2. Utilities | 1. TCP/IP Settings
Wi-Fi Setting: Power Saving CipherNet Runtime Menu | 2. Utilities | 1. TCP/IP Settings

Login CipherNet Runtime Menu | 2. Utilities | 2. Emulation Settings
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System Menu — Press 7, 9 and the Power key simultaneously on the mobile computer.
1P System Menu | 8. Next Page | 3. Wi-Fi Menu | 2. Network Setting
System Menu | 8. Next Page | 3. Wi-Fi Menu | 3. WLAN Setting

Security System Menu | 8. Next Page | 3. Wi-Fi Menu | 4. Security
IN THIS CHAPTER
3.1 LOCAl TP e 22
3. 2 HOSE TP e 23
3.3 WLAN INterface «.vviirii it e e 23
T Y <o | ) Y 23
3.5 L0giN cii i 24
3.6 RS .ot e 26
3.1 LOCAL IP
3.1.1 ENABLE DHCP SERVER

By default, DHCP server is enabled and all the settings can be obtained from it.

If DHCP server is disabled, you must provide the following information —

Subnet Mask
Gateway
DNS Server
Terminal IP

v Vv Vv Vv

3.1.2 LOCAL NAME
You may enter a name for identifying the mobile computer.
3.1.3SSID

This refers to Service Set ID or Identifier, which serves to uniquely identify a group of
wireless network devices used in a given “Service Set”. For example, you need to specify
the same SSID here as is used for access points so that the mobile computer can
associate to the access points.

Note: SSID can be made up of 32 characters maximum.
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3.2 HOST IP

3.2.1 HOST IP/NAME

Specify the IP address or name of the host that you wish to access via telnet.

3.2.2 TELNET PORT

Specify the telnet port number. Port 23 is assigned by default.
3.2.3 KEEP ALIVE

During a normal telnet session, a host will send a checking packet to the mobile
computer on a regular basis to maintain the connection. However, the host you access
might not be configured to keep the session alive. In that case, you can have the mobile
computer automatically send a checking packet to the host at intervals.

» By default, the value is set 0; that is, this feature is disabled.
» Specify the interval in the range of 0~255, in units of minute.

3.3 WLAN INTERFACE

Select “Wi-Fi” for 802.11b/g connectivity, and proceed to configure Wi-Fi security
settings.

» Enable the Power Saving setting if necessary.

3.4 SECURITY

Authentication and encryption help provide data protection on the 802.11b/g network.
Refer to 3.3 WLAN Interface.

3.4.1 OPEN SYSTEM/SHARED KEY

Two types of network authentication methods are supported: Open System and Shared
Key.

Setting Remark

Open System Using Open authentication, any wireless station can request authentication. The
station that needs to authenticate with another wireless station sends an
authentication management frame that contains the identity of the sending
station. The receiving station or AP will grant any request for authentication.

» Open authentication allows any device network access. If no encryption is
enabled on the network, any device that knows the SSID of the access point
can gain access to the network.

Shared Key Using Shared Key authentication, each wireless station is assumed to have
received a secret shared key over a secure channel that is independent from the
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802.11b/g wireless network communications channel.

» Shared key authentication requires that the client configure a static WEP key.
The client access will be granted only if it passed a challenge based
authentication.

Note: For Shared Key authentication, the active WEP key is used for authentication.

3.4.2 WEP KEY

Select the check box to implement Wired Equivalent Privacy or Wireless Encryption
Protocol (WEP) for data encryption.

Setting Remark

Key Length Encryption type can be 64 bits (5 bytes) or 128 bits (13 bytes). You can also
choose to password protect it to ensure privacy. The password phrase is used to
generate a WEP key automatically. You have the option of either using a password
phrase or entering a WEP key manually.

» Using 64-bit encryption, the password phrase can be 5 characters long.
Enter up to 5 characters (ASCII codes) for the WEP key.

» For 128-bit encryption, the password phrase can be 13 characters long.
Enter up to 13 characters (ASCII codes) for the WEP key.

Key 1 ~ 4 Key index number. Up to four WEP keys can be configured.

Active Only one key (the active one) can be used at a time.

Note: You must use the same settings as configured for other devices on your wireless
network, e.g. access points.

3.4.3 WPA-PSK/WPA2-PSK PASSPHRASE

WPA-PSK is supported to enhance security over wireless networks, and this Pre-Shared
key mode requires a passphrase to access the network. The passphrase must be 8 to 63
characters (ASCII codes).

» For 8400, it also supports WPA2-PSK!

344 EAP

Select the check box to enable authentication using Extensible Authentication Protocol
(EAP). It requires user name and password so that the mobile computer can identify
itself when associating to Cisco® access points.

Setting Remark
Identity Specify a user name. (32 characters maximum)
Password Specify a password. (32 characters maximum)
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3.5 LOGIN

To successfully log on to a host, the following settings must be specified correctly.

Note: After logging out properly, press ESC and FN (the function key) simultaneously to
disconnect with the host and return to the main menu.

3.5.1LOGIN

Normally, the cursor will stay on the “Username” field waiting for input during a fresh
new telnet session. Instead of using the arrow keys to move the cursor to the “Password”
input field, you may press the function key or key combination mapped to “"NEXT". For
example, you may map the physical Tab key to "NEXT” for 8500 Series. Refer to 4.7
Func Toggle & Function Key Mapping.

Setting Remark
Username, Specify username and password for logging on to the host you wish to access.
Password

Shortcut Key By default, the shortcut keys are disabled. You will have to enter the username
and password manually.

P Select the shortcut keys (FN+0 ~ FN+9) so that you can enter the text string
for Username and Password by two strokes. Each selected key combination
will become unavailable on the Function Key Mapping list. For example, if you
select FN+0 for “Username” and FN+1 for “Password”, you will find them
mapped to “Name Key” and “Password Key” individually in the Function Key
Mapping on the Emulation tab.

Note: Use the shortcut keys to enter the text string for Username/Password by two
strokes. For this feature to work properly, Username/Password must be specified
correctly.

3.5.2 AUTO SIGNON

By default, this feature is disabled. The host will request Username and Password every
time the mobile computer attempts to log on.

» If this feature is supported by the host, select the check box so that the mobile
computer can be allowed to automatically log on to the host. Refer to 3.5.1 Login.

Note: For this feature to work properly, Username/Password must be specified correctly
and cannot exceed 20 characters.
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3.6 RESET

Click Reset to load the default settings.

Note: The current settings will be cleared.
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Chapter 4
EMULATION SETTINGS

To successfully emulate an IBM 5250 terminal, emulation settings must be configured
correctly. Once the configuration file (.NET) has been downloaded to the mobile
computer, the new settings will take effect immediately and become the defaults.
However, you still can change many of the settings directly on the mobile computer via
CipherNet Runtime Menu or System Menu:

CipherNet Runtime Menu — Press the Power key on the mobile computer.

Screen Scroll & Control CipherNet Runtime Menu | 2. Utilities | 2. Emulation Settings

21

System | Barcode | Wireless LAN  Emulation | Sereen | GPRS |

5 Jrield Length # Excesd { B JLock Screen

& Small (5x8) * Feject X |[:-_ Y |[:-_

" Truncate
" Large (&16) " Split To Next Field I Lock Screen

Ilcun 'l

AT B IDisabIe jv FuncToggle: ILInIu:u:ked j Keypad Type: IEE-DD 44-TE Key j
Horizontal Steps |15' [ 8} et | [ 7 '
LR S IE — Function Key Mapping

¥ Cursor Tracking ll = PF1 ﬂl = PF11 ﬂl == PF21
[~ Tim Spaces il => PF2 E =» PF12 El => PF22
™ Remove Empty Line ﬂ == PF3 ﬂ = PF13 ﬂ =: PF23
I™ Cursor Fashing F4 | =>PFa ﬂl => PF14 ﬂ| => PF24
@es&age _F5 | =>PF5 _Fl5 | =>PF15 Inset | => INSERT
Line Mumber 24 = il => PFg ﬂl =» PF16 ﬂl =» DELETE
Function Key Disable = il =>PF7 il =>PF17
Time Out (Second) |2 _Fe |=pre _F1g | =>PF13
=3 == PF19
Eﬁ;ﬂe [cOPYRIGHT ﬁ N :::‘u % orap

K I Cancel
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4.1 LANGUAGE

By default, single-byte characters are used for the current language setting, i.e. English.
If you select any language other than English from the drop-down menu, you need to
download the font file for the selected language in advance. Otherwise, the language
settings will not take effect. Refer to 1.4 Change Prompts & Messages.

Language Option Font File Required Font Size

Single Byte Character (English) Single-Byte N/A (default system font) Depends on 4.4 Font
Size setting

Traditional Chinese Double-Byte | TC font file font size 16x16

Simplified Chinese Double-Byte  SC font file font size 16x16

Korean Double-Byte | KR font file font size 16x16

Japanese Double-Byte | JP font file font size 16x16

Greek Single-Byte Multi-language font file Depends on 4.4 Font
Size setting

French Single-Byte Multi-language font file Depends on 4.4 Font
Size setting

4.2 SCREEN SCROLL & CONTROL

Limited to the actual screen size, the mobile computer can only display a portion of the
host screen. The following features help ease working from the terminal screen.

4.2.1 NAVIGATOR

A navigator can be a graphic icon or miniature window on the terminal screen, indicating
the relationship between the terminal screen and the host screen. A miniature cursor is
blinking to indicate the input position.
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Options Remarks
None Disable the navigator.
Icon By default, a graphic icon is used for navigation.
> Take 8500 Series for example. The icon will appear on the bottom line of the
screen.
20*15 Instead of the small icon, you may select "20*15” or “32*24" for a larger icon.
32%*24 » Take 8500 Series for example. The icon will take the top few lines of the screen.
4.2.2 NAVIGATOR KEY

The navigator key works as the toggle of navigator. When you press the navigator key on
the mobile computer, it will hide or show the navigator by turns.

» On 8300/8400/8500 Series, the navigator key only works when a larger icon (20*15
or 32*24) for navigator is applied.

Options Remarks

Disable By default, the navigator key is disabled.

FN+0 ~ Select a function key combination for the navigator key.

FN+9 P Select the navigator key (FN+0 ~ FN+9). The selected key combination will

become unavailable on the Function Key Mapping list. For example, if you select
FN+6, you will find it mapped to “Navigator Key”.

4.2.3 HORIZONTAL STEPS

Specify how many horizontal steps the cursor will move at a time on the host screen
when you press the following key combinations simultaneously -

» FN + Left (for 8300/8400/8500 Series) or FN + “-+$"” (for 8000 Series)
» FN + Right (for 8300/8400/8500 Series) or FN + “%4#e" (for 8000 Series)

4.2 4 VERTICAL STEPS

Specify how many vertical steps the cursor will move at a time on the host screen when
you press the following key combinations simultaneously -

» FN + Up
» FN + Down

Note: The horizontal and vertical steps are associated with the font size.

4.2.5 CURSOR TRACKING

This feature is enabled by default. The terminal screen will automatically adjust itself so
that the cursor will always be visible on the screen. Thus, every screen received from the
host will be displayed with the cursor visible to indicate the first input field.

29



MIRROR 5250 Emulator User Guide

Refer to 4.6 Lock Screen. When the Lock Screen feature is enabled, the Cursor Tracking
feature will be disabled automatically; and vice versa.

Note: This feature only works when a screen refresh incident occurs on the host.

4.2.6 TRIM SPACES

Select the check box to make the most use of the terminal screen; unnecessary spaces
will be discarded. Take the following for example.

Original line: -> 1. Set up<-

Trimmed ->1. Set up<-

Note: Spaces between characters will not be discarded.

4.2.7 REMOVE EMPTY LINE
Select the check box to automatically ignore empty lines on the host screen.

Note: This feature can only be enabled when there is no contradiction with 5250’s field
definition.

4.2.8 CURSOR FLASHING

Select the check box to have a flashing cursor.

4.3 MESSAGE

On an IBM 5250 terminal, a message line is reserved to display messages from the host.
Now we provide a more flexible way to do this: take down the message from the
specified line and display it in a dialog box on your mobile computer.

Manipulating the dialog box by its display duration or recalling it by pressing the

associated function key combination, you will be able to follow the messages more
closely.

Note: The message dialog box appears on the mobile computer automatically whenever
a message from the host is detected.

Settings Remarks

Line Number Specify which line on the host screen is the message line so that the mobile
computer can grab a message to a dialog box. The default is line 24.
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Function Key This function key is used to recall the most recent dialog box after it has been
closed due to a specified time-out.
» By default, the message key is disabled.

P Select the message key (FN+0 ~ FN+9). The selected key combination will
become unavailable on the Function Key Mapping list. For example, if you
select FN+7, you will find it mapped to “"Message Key”.

Timeout Specify a period of time before the dialog box is closed, in units of second.

Exclude String = To skip unnecessary messages, you may specify a text string so that any message
containing this string will be ignored. That is, no dialog box will appear to display
such message.

4.4 FONT SIZE

The terminal screen size varies by the mobile computer. Display capability, as shown
below, depends on the screen size as well as the font you use. Refer to 1.4 Change
Prompts & Messages.

Mobile Computer Small (Font 6x8) Large (Font 8x16)

8000 Series 16 characters by 8 lines (default) |12 characters by 4 lines
8300 Series 20 characters by 8 lines (default) | 15 characters by 4 lines
8400 Series 26 characters by 18 lines (default) 20 characters by 9 lines
8500 Series 26 characters by 19 lines (default) 20 characters by 9 lines

The font size setting affects single-byte languages as well as the alphanumeric characters
for double-byte languages. Refer to 4.1 Language.

» By default, small font (6x8) is applied. Data coming in from the host will be displayed
accordingly.

» Large font (8x16) must be applied for double-byte languages, such as Chinese,
Japanese, etc. In that case, select the check box first so that all the prompts and
messages will use large font. Proceed to 1.4 Change Prompts & Messages.

This setting also affects the default horizontal/vertical steps the cursor move at one time
on the host screen.

4.5 FIELD LENGTH IF EXCEED

In 5250's field definition, the length of data field is pre-defined. If the input data is longer
than the specified field length, you may decide how to deal with it.

Options Remarks

Reject Simply reject the input data.

Truncate Discard the part that exceeds the field length. The rest of data is
accepted.

Split to Next Field The whole data is accepted.

The part that exceeds the field length will be displayed in next field.
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4.6 LOCK SCREEN

By default, the upper-left point of the terminal screen is not locked when the cursor
tracking feature is enabled. That is, the terminal screen will automatically adjust itself so
that the cursor will always be visible on the screen.

» Select the check box if the Lock Screen feature is desired. Then, proceed to specify
the relative coordinates for the upper-left point of the terminal screen when being
mapped on the host screen.

Note: This feature is suitable for host applications when the desired information is
always displayed closely and fit to the terminal screen. When the Lock Screen
feature is enabled, the Cursor Tracking feature will be disabled automatically; and
vice versa.

The coordinates (0,0) on the terminal screen are related to (X,Y) on the host screen.
Thus, every screen received from the host will be first displayed starting from (X,Y)
regardless of the cursor. The relationship between the terminal screen (small) and the
host screen (large) is based on the upper-left point of the screens (see below).

Sign On
System . .
Lock Screen Fubsyatem .
to G(sz Display . .
4
(=== . . . . . . I
Fass -l -

The cursor is outside of the terminal screen (see above). To view the hidden information
or locate the cursor, you need to adjust the terminal screen manually.

Horizontal / Vertical Steps

Press the following key combinations simultaneously -

» FN + Left (for 8300/8400/8500 Series) or FN + “-+$" (for 8000 Series)
» FN + Right (for 8300/8400/8500 Series) or FN + “%#e" (for 8000 Series)
» FN + Up
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> FN + Down

When the Cursor Tracking feature is enabled, there will be a warning beep to indicate that the
terminal screen has reached the boundaries of the host screen.

When the Lock Screen feature is enabled, there will be a warning beep to indicate that for the first
time the terminal screen has reached the boundaries of the host screen. If you persist, the terminal
screen will be re-positioned to (X,Y).

Note: For 8500 Series, the above function keys are originally used to adjust LCD
contrast (FN + Up/Down) and backlight intensity (FN + Left/Right). After
logging on to a host, these keys will be used to adjust the terminal screen instead.
That is, you cannot use them to adjust LCD contrast and backlight intensity until
you log out.

Cursor Movement

» To move the cursor to a desired input field, press the function key that is mapped to “NEXT”.
» To move the cursor to a desired input point, press the arrow keys Up, Down, Left, and Right.

4.7 FUNC TOGGLE & FUNCTION KEY MAPPING

The function key or key combination is one of the keys on the mobile physical keypad
that transmit control codes. Control codes do not produce displayable characters but are
codes for functions. If these codes are received by the mobile computer, it will perform
the associated function as defined.

4.7.1 FUNC TOGGLE

Generally, a function key combination, which requires pressing FN to enter the function
mode, works as follows —

I) Press FN on the 8300/8400/8500 Series mobile computer.
There will be an “F” icon on the screen to indicate the function mode is on.

2) Press the second key to get the value of a key combination (say, press the number
key 1 to get the value of F1). The icon will go off as the function mode is toggled off.

To have the function mode persist, you may choose to lock the function toggle in
advance so that it will not be toggled off automatically.

3) To get the value of another key combination, repeat the above steps.

To abort the function mode, press FN again and the icon will go off.

Note: For 8300/8400/8500 Series, the function key is unlocked by default.
For 8000 Series, the function key only works with the function toggle locked.
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Function Toggle Remark

Unlocked The function mode is toggled on by pressing the function key.

(also known as Auto Resume 1t can be toggled off by pressing the second key of the key
mode) combination.

Locked The function mode is toggled on by pressing the function key.

(also known as Toggle mode) It can only be toggled off by pressing the function key again.

4.7.2 KEYPAD TYPE

The following options for keypad layout are supported for 8300/8400/8500 Series. Select
the matching keypad type first, and map the available function keys to meet your needs.

Mobile Computer | Keypad Type Remark

8300 Series 8300 24 Key .i
2300 29 Ke

8400 Series 8400 29 Key .i
2400 39 Ke

8500 Series 3500 24 Key 44-TE Key is a new option specifically provided for terminal
8300 44 Key k emulation use!
8500 44-TE Ke

4.7.3 KEY MAPPING

By default, FN+1 ~ FN+9 are mapped to PF1 ~ PF9 (Program Function keys). Click an
available function key and change its mapping to meet a specific need.

Note: The function key mapping list varies by the mobile computer and keypad layout. If
a specific key is not available on the physical keypad, its associated key mapping
may not take effect.

For example, the following function keys may be required during a telnet session.

Function Key Mapped to Remarks

Any available key F3 Exit the sign-on request.

Any available key F12 Cancel a task.

Any available key Switch Key See 2.2 RFID Reader

Tab or any other key NEXT See 3.5.1 Login - Username/Password
Any available key Name Key See 3.5.1 Login - Username/Password
Any available key Password Key See 3.5.1 Login - Username/Password
Any available key Navigator Key See 4.2.2 Navigator Key.

Any available key Message Key See 4.3 Message.
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4.8 RESET

Click Reset to load the default settings.

Note: The current settings will be cleared.
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Chapter 5
SCREEN REFORMATTING

The screen reformat feature requires you to enable it by entering the activation key on
the mobile computer; otherwise, the screen settings cannot take effect. If you have
received an activation key, proceed with the screen capture task.

Note: CipherLab will issue a unique activation key under the pay-by-use policy. Please
contact your local sales representative for licensing.

IN THIS CHAPTER

5.1 Activate the Screen Reformat Feature.........coovvviiiiinnnnnnn 37
5.2 Capture Host Session SCreens ....ovvviiiiieviiiiiiniiiinneeanns 38
5.3 Reformat HOSt SCreens .....oviiiiiiiiiiiiiiiiiiii e eeeeeas 40

5.1 ACTIVATE THE SCREEN REFORMAT FEATURE

I) Press Power on the mobile computer to enter the CipherNet Runtime Menu.
2) Select 2. Utilities | 2. Emulation Settings |8. Activation Key.

LB il B R R

1l.Telnhet

2 Tiliti

_Emulation Type
.Login Name

.Login Password
.Navigator

_Hori &croll Steps
. Wert Bcroll Steps=s
.Cursor Tracking

_Actiwvation Eevy

= 3
_TCPFIP Sectings
_Emulation Eettingil
.RBeader Test
_Backlight *
.Battery Woltage

.Bet Date & Time
-Baud BRate
_Dowmload

00 -1 T O e QO]
] -] T 0 e QO M)

3) Scan the activation barcode (or enter the activation key you received).
4) Return to the main menu and select 1. Telnet.

A new session will start with reformatted screens.
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5.2 CAPTURE HOST SESSION SCREENS

5.2.1 LOGON TO HOST

I) Run the CipherNet program on your computer.
2) Click OK to accept the End-User License Agreement (EULA).

3) Connect to the host via Telnet Menu | Connect or click ﬁl on the toolbar.
4) Enter the IP address of the host that you wish to access via telnet.

Select the check box of Save Log in case you need to analyze the activities during a
telnet session. The information will be saved to a log file in the “Logs” folder
automatically created in the same directory where the CipherNet program is.

Host P x|

Fleaze input Hozt IP address

-|1EE -|1 -|1nn

[T Savelog

5) Click OK to start connecting to the host. The host system will prompt you to enter
username/password to login as shown below.

% CipherNet Terminal Emulation For 5250 118 10 x|
File Utilities Telnet Help

ml[=2=]] || » k| m| [8500 -

Sign On
System . . . . .t CIPHERTW
Subsystem . . . . QINTER
Display . . . . . : QPADEVOOO4G
HSEE & 8 3 G iR AR R R e e I

Password . . . . . . . . . . ..
Program/procedure . . . . . . . .
Menu . . . - o & . 0 e e e
Current library . . . . . . . . .

| 4

6) After login, you may start using the host application you need.

Note: Wireless LAN networking settings must be configured properly.
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5.2.2 CAPTURE HOST SCREENS

You may capture screens from the host application using the associated commands via
Telnet Menu or the following icons on the toolbar. A status message will appear on the
left bottom of the CipherNet window, indicating the current status.

I) Click Ll to start the capture task and save the host screens to a .SCR file.

(Status message: Ready to capture)

2) Click ﬂl to capture the current host screen. Skip unnecessary screens.
(Status message: A total of screens that have been captured.)

3) Click |L| to stop the capture task when you have captured the screens necessary for
the terminal operation during a normal session.

4) Proceed to reformat host screens via Utilities Menu | Configure.

Note: Try to capture all the necessary screens. If you cannot decide which screen to skip
now, capture it. You can always delete it later when the .SCR file is loaded for
screen reformatting.
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5.3 REFORMAT HOST SCREENS

The target is to reformat the captured host screens, or pages, so that they can be best
displayed on the terminal screen.

The Screen settings page is divided into two parts: one is a window (left) displaying the
captured host screens for viewing and editing, and the other is the associated forms
(right) for reformatting these pages to fit in the terminal screen.

5.3.1 HOST SCREEN

| Load Host Seszion Screens...l | Total Pages 3

Delete Current Page ... | Current Page: 1

Sign On =
System .....:
Subsystem . ..
Display .....:

User ..............

Password ............
Programf{procedure . . .... ..

Menu .............. b
Current library . . .... ...

4 -l

[Row, Column] = [0, 0] |<<| <<| >>| >>||

Load Host Session Screens

Load Host Sezszion Screens. .. I

Click to import the screens from a .SCR file. The total of pages, or
screens, is displayed next to the button.

Click on any part of the window. The current position (Row, Column) will be displayed accordingly.

» Drag the horizontal/vertical scroll bars to view the hidden text of the current page.
» Click the four control buttons to change the page currently displayed -

e e

I—I for displaying the first page —I for displaying the previous page
= =

_| for displaying the next page —Hl for displaying the last page
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Delete Current Screen

Click DetobmenEae if the screen currently displayed is not desired for reformatting.

The current number of page, or screen, is displayed next to the button.

Note: If you neither delete nor reformat a captured screen, there will be an empty
screen displayed during a telnet session.

5.3.2 TERMINAL SCREEN
Feformat page 1 ko |4EI characters * 16 Iineﬂ
IFieIu:I Moy Terminal Screen Line NDI

[l <[ [ [ Mainben :
[ =] [B2[f [Passwordt 3
[z =gz 7 [Frogiam 4
ER :
5 =|[E2[8 |y 3
ol || :
[l =] [ [ [welcome to CipherLab z

L *r Reszet

Reformat Page ... to

Specify the page format on the terminal screen. You can have different page format for different
host screen.

» This setting or its options depend on the font size you use in 4.4 Font Size.

Field (x, y)

If the original message of a line does not prompt you to input selection, i.e. no input fields, leave
it as “nil”.

If the original message of a line prompts you to input selection, select the matching field number
and rephrase its message if necessary. The total of fields on the host screen is reflected in the
drop-down menu of Field.
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Terminal Screen (Messages)

Copy the necessary messages from the Host Screen window and rephrase them, if necessary, to
fit to the terminal screen.

Line No.

This indicates the line number when the message is displayed on the terminal screen.

Control Buttons

If the total lines of page format setting exceed 8, the two buttons will become available for moving
forward or backward to display the rest lines.

Reset

Click Reset to load the default settings.

Note: The current host screens and settings for reformatting will be cleared after clicking
Reset.

5.3.3 EXAMPLE

System | Barcode | Wireless LAN | Emuiation Sereen | GPRS |

| Load Host Session Screens...l Total Pages: 3 Feformat page 1 to: |40 characters * 15 lines j
Delete Curent Page .. | Curmrent Page: 1 Field My Temiinel Seresm Line Mo.
Sign On ] Ini| j I_I_I b ain kenu i
System .....:

Subsystem . . . . [ =] [g2[p [usemame: 2

Display . ....: ﬂ IEIE_IF'aSSWDrd: ;
e — [ = oo !
ety A = EE e ;
Current library . . ....... Iﬂ EF|Lihrary: i
[ =l 7
4] | Llj [l <[ [ [weleome to CipherLat 8

[Row, Column] = (0, 0) ﬁlililﬂl <<| >>| Reset |

(] | Cancel |
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» You have loaded a total of 3 host screens, and currently work on the first page.

» From the Host Screen window (left), you can see there are four message lines and
one empty line on this page. You may ignore the empty lines and simply skip them
when reformatting.

» Copy the necessary messages for reformatting (right). You may need to rephrase
them so that they can best fit in to a terminal screen, which is decided by the page
format of the terminal screen.

Note: The coordinates of a Field can be ignored if the message is not requesting you to
input information.

» Below shows the messages displayed on the host screen before reformatting, and
those rephrased to be displayed on the terminal screen after reformatting.

Rows |[Host Screen Lines [Terminal Screen
1 Sign On 1 Main Menu

2 System... 2 Username:

3 Subsystem... 3 Password:

4 Display... 4 Program:

5 User... 5 Menu:

6 Password... 6 Library:

7 Program/procedure... 7 (empty)

8 Menu... 8 Welcome to CipherLab
9 Current library... 9

(before reformatting) (after reformatting)

» Proceed to next host screen by clicking il at the bottom of Host Screen window. If
a host screen is not desired for reformatting, you must delete it by clicking

Delete Current Fage ...

; otherwise, it will become an empty screen during a telnet
session.
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Chapter 6
GPRS SETTINGS

The GPRS connectivity is only supported for 8500 Series.

» Access Point Name — name of access point that connects the mobile network to the
Internet

» IP address (DHCP or static)

» User name and password (may be optional, depending on Challenge-Handshake
Authentication Protocol)

System I Barcode I Wireless LAM I Emulation I Screen |

System | Barcode | Wireless LAN I Emulation | S

—GFRS

[” Enable GPRS

GFRS Access Point Mame: Icmnet

I | Enable FIN Code |

[T | Enable EHAR Authentication:

CHAP UszerM anme: I

CHAF Pazaword: I

¥ Enable DHER

Terminal IP: IU-U-U.U

QK I Cancel

Once the configuration file (.NET) has been downloaded to the mobile computer, the new
settings will take effect immediately and become the defaults. However, you still can

change many of the settings directly on the mobile computer via CipherNet Runtime
Menu or System Menu:
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CipherNet Runtime Menu — Press the Power key on the mobile computer.
GPRS Settings CipherNet Runtime Menu | 2. Utilities | 1. TCP/IP Settings

System Menu — Press 7, 9 and the Power key simultaneously on the mobile computer.

Access Point Name System Menu | 8. Next Page | 3. GSM/GPRS Menu | 3. GPRS
Settings

Enter PIN Code System Menu | 8. Next Page | 3. GSM/GPRS Menu | 2. Security

CHAP Authentication System Menu | 8. Next Page | 3. GSM/GPRS Menu | 3. GPRS
Settings

DHCP System Menu | 8. Next Page | 3. GSM/GPRS Menu | 3. GPRS
Settings

Note: Please contact your Internet service provider (ISP) or network operator for
information on GPRS related settings.

If you are using 8580 or 8590 with SIM card installed properly, select the check box to
enable GPRS first. Then, give PIN code for SIM card and other information necessary for
establishing a GPRS connection.

System I Barcode I Wireless LAN I Emulation I Screen GFRS |

—GFPRS
¥ Enable GPRS

GFRS Acceszs Point Marne: Il:mnet

[~ Enable FIN Code |

[™ Enable CHAP Authentication:

CHAP UserM ame: I

CHAP Pazzword: I

¥ Enable DHCP

Terminal |P: ID-UU.U

oK I Cancel
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ltem Remark

Access Point Name Required

PIN Code Required if not using default

CHAP User Name & Password Depends on CHAP authentication setting

IP Address, dynamic or static Required; provide a static IP if DHCP is disabled
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SCAN ENGINE SETTINGS

Appendix |

The MIRROR Terminal Emulator allows configuring the
depending on the module equipped on your mobile computer:

following reader

types,

8000

8300

8400

8500

Barcode Reader

1D CCD Scan Engine

1D Laser Scan Engine

1D Long Range Laser Scan Engine (LR)

NIENIRN

1D Extra Long Range Laser Scan Engine (ELR)

x

2D Scan Engine

N IENIENIEN AN

RFID Reader

ACG_RFID Module v0.9

X

X

x

ACG_RFID Module v1.0

x

v

x

Options of different reader combination are allowed, such as 1D+RFID and 2D+RFID. For
each combination, both readers can be initialized and ready for scanning at the same
time (dual mode operation). For example, if you press the SCAN button while running
the CipherNet run-time program on the mobile computer, it will read a barcode in
position or an RFID tag in proximity depending on which one comes first.

Note: You cannot have 1D+2D scan engines installed on the mobile computer because

they are both barcode readers!

SYMBOLOGIES SUPPORTED

Varying by the scan engine installed, the supported symbologies or tag types are listed
below. For details on configuring associated settings, please refer to each Appendix

separately.
CCD, Laser |LR, ELR 2D

Codabar v v v
Code 11 x x v
Code 93 v v v
Composite Code x x v
MSI v v v
Plessey x x
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Postal Codes x x v
Telepen v x x
Code 128 Code 128 v v v
GS1-128 (EAN-128) v v v
ISBT 128 v v v
Code 2 of 5 Industrial 25 (Discrete 25) 4 v v
Interleaved 25 v v
Matrix 25 v x 8400*
Chinese 25 v x 8400%

Note: Matrix 25 and Chinese 25 are supported on 2D scan engine for 8400 only.

Code 3 of 9

Code 39

Trioptic Code 39

x

Italian Pharmacode (Code 32)

NIV I

NERNE

French Pharmacode

x

x

EAN/UPC

EAN-8

EAN-13

Bookland EAN (ISBN)

UPC-EO

NIIEN RN RN IRV RN

UPC-E1

x

UPC-A

GS1 DataBar
(RSS)

GS1 DataBar Omnidirectional (RSS-14)

GS1 DataBar Limited (RSS Limited)

GS1 DataBar Expanded (RSS Expanded)

NIIENIRN N

NENERNBNERERERERE

2D Symbologies

PDF417

x

x

MicroPDF417

x

Data Matrix

x

Maxicode

QR Code

NIEN RN IRV RN RN RN RNV RN RNV RN RN IRV RN
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RFID TAGS SUPPORTED

The RFID reader supports read/write operations depending on the tags. The supported
labels include ISO 15693, Icode®, ISO 14443A, and ISO 14443B. Currently, the
performance of some tags has been confirmed, and the results are listed below for your
reference. The results found with RFID module version 1.0 are different from those found

with version 0.9 or older versions.

Appendix |

Note: You should study the specifications of RFID tags before use.

ACG_RFID Module Version 1.0

Scan Engine Settings

UID Only

Read Page

Write Page

ISO 14443A

Mifare Standard 1K

v

Mifare Standard 4K

v

Mifare Ultralight

Mifare DESFire

Mifare S50

SLE44R35

SLE66R35

ISO 14443B

SRIX 4K

SR176

ISO 15693

ICODE SLI

SRF55V02P

SRF55V02S

SRF55V10P

TI Tag-it HF-1

ICODE®
(Phillips)

ICODE

NIIEN RN RN RN RN RN RNV RN RN IRV RN IRV B

ACG_RFID Module Version 0.9

UID Only

Read Page

Write Page

ISO 14443A

Mifare Standard 1K

Mifare Standard 4K

Mifare DESFire

Mifare S50

SLE44R35

SLE66R35

ISO 15693

ICODE SLI

SRF55V02P

SRF55V02S

NINEREBNERERBERER
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SRF55V10P 4 v 4

TI Tag-it HF-I v v v

ST LRI64 v v v

ST LRI512 v v v
Tagit® Tagit v v v
ICODE® ICODE v v v
(Phillips)
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CCD/LASER SCAN ENGINE

The tables below list reader settings as well as symbology settings for the CCD or Laser
scan engine.

READER SETTINGS TABLE

CCD/Laser Engine Description Default
Scan Mode Laser mode
Continuous Mode Non-stop scanning

» To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode Non-stop scanning

» Capable of decoding the same barcode repeatedly

Repeat Mode Non-stop scanning

» Capable of re-transmitting barcode data if triggering within one second
after a successful decoding

Momentary Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until you release the trigger.

Alternate Mode Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.

» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.

Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (@) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Auto Power Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until the preset timeout expires, and, the
preset timeout period re-counts after each successful decoding.

Read Redundancy None

None No redundancy means one successful decoding will make the reading valid
and induce the "READER Event".
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One time, Two times,
or Three times

The higher the reading security is (that is, the more redundancy the user

selects), the slower the reading speed gets.

P If "Three Times" is selected, it will take a total of four consecutive
successful decodings of the same barcode to make the reading valid.

Time-out

3 sec.

0~255 (second)

Set the maximum time for decoding to continue during a scan attempt.

It applies to the following scan modes only -
» Aiming mode

» Laser mode

> Auto Off mode

» Auto Power Off mode

SYMBOLOGY SETTINGS TABLE

CCD/Laser Engine Description Default
Codabar Enable
Transmit Start/Stop [ Decide whether to include the start/stop characters in the|No
Characters data being transmitted.
If "Transmit Start/Stop Characters" is desired, select one
set:
» abcd / abcd
» abcd / tn*e
» ABCD / ABCD
> ABCD / TN*E
Code 128 Enable
GS1-128 (EAN-128) Enable
Transmit Code ID (for|Decide whether to include Code ID (*]C1") will be included | No
EAN-128) in the data being transmitted.
Replace Field | Decide whether to replace the field separator. If the|No
Separator barcode contains Field Separator “0x1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“0x1D”, it will be changed to %;".
ISBT 128 Enable
Industrial 25 (Discrete 25) Enable

Start/Stop Selection

This decides the readability of all 2 of 5 symbology
variants. For example, flight tickets actually use an
Industrial 2 of 5 barcode but with Interleaved 2 of 5
start/stop pattern. In order to read this barcode, the
start/stop pattern selection parameter of Industrial 2 of 5
should set to "Interleaved 25".

Industrial 25

Verify Check Digit

Decide whether to verify the check digit. If the check digit
is incorrect, the barcode will not be accepted.

No
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CCD/Laser Scan Engine

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Select Length » One or two fixed lengths 1~127
» Range

Interleaved 25 Enable

Start/Stop Selection

Refer to Industrial 25.

Interleaved
25

Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Select Length P One or two fixed lengths 1~126
» Range

Matrix 25 Disable

Start/Stop Selection Refer to Industrial 25. Matrix 25

Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Select Length P One or two fixed lengths 1~127
» Range

French Pharmacode Disable

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Italian Pharmacode (Code 32) Disable

Transmit Check Digit Decide whether to include the check digit in the data being|Yes

transmitted.

Note: For French/Italian Pharmacode, “Transmit Start/Stop Character” is not provided in
UI but it is controlled by the same setting of Code 39.

Code 39 Enable
Transmit Start/Stop | Decide whether to include the start/stop characters "*" in|No
Character the data being transmitted.
Verify Check Digit Decide whether to verify the check digit. If the check digit |No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and|Disable
special characters.
Code 93 Enable
MSI Disable
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Verify Check Digit

Select one of the three calculation formulas to verify the
check digit. If the check digit is incorrect, the barcode will
not be accepted.

» Single Modulo 10
» Double Modulo 10
» Modulo 11 & 10

Single Modulo
10

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

» Last digit not transmitted

Both digits
transmitted

» Both digits transmitted
» Both digits not transmitted
Select Length » One or two fixed lengths 0~127
» Range
Negative Barcode Disable
Plessey Disable
Convert to UK Plessey |When applied, each occurrence of the character "A" in the|No
barcode data will be replaced by the character "X".
Transmit Check Digit Decide whether to include the two check digits in the data|Yes
being transmitted.
Telepen Disable
Original Telepen | The original Telepen includes numeric characters. Yes
(Numeric)
AIM  Telepen (Full { AIM Telepen (Full ASCII) includes all the alphanumeric and | No
ASCII) special characters.
GS1 DataBar Omnidirectional (RSS-14) Disable
Transmit Code ID Decide whether to include Code ID ("]e0") will be included |Yes
in the data being transmitted.
Transmit Application [ Decide whether to include the Application ID ("01") in the|Yes
ID data being transmitted.
Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.
GS1 DataBar Limited (RSS Limited) Disable
Transmit Code ID Refer to RSS-14. Yes
Transmit Application | Refer to RSS-14. Yes
ID
Transmit Check Digit Refer to RSS-14. Yes
GS1 DataBar Expanded (RSS Expanded) Disable
Transmit Code ID Refer to RSS-14. Yes
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the|No

next processing will follow the settings configured for
EAN-13.
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Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

Yes

Addon 2 / Addon 5

Decide whether to decode EAN-8 with supplementals.

No

EAN-13 / UPC-A

Enable

ISBN Conversion

The EAN-13 barcode starting with 978 and 979 will be
converted to ISBN.

No

ISSN Conversion

The EAN-13 barcode starting with 977 will be converted to
ISSN.

No

GTIN for EAN-13 The EAN-13 barcode will be expanded into 14-digit Global |No
Trade Item Number (GTIN).

Transmit Check Digit Decide whether to include the check digit in the data being|Yes
transmitted.

Addon 2 / Addon 5 Decide whether to decode EAN-13/UPC-A  with|No

supplementals.

(UPC-A) Convert to|The UPC-A barcode will be expanded into EAN-13, and the|Yes

EAN-13 next processing will follow the settings configured for
EAN-13.

(UPC-A) Transmit| Decide whether to include the UPC-A check digit in the|Yes

Check Digit data being transmitted.

(UPC-A) Transmit| Decide whether to include the UPC-A System Number in|Yes

System Number the data being transmitted.

UPC-E Enable

Convert to UPC-A

The UPC-E barcode will be expanded into UPC-A, and the
next processing will follow the settings configured for
UPC-A.

No

Transmit Check Digit Decide whether to include the UPC-E check digit in the|Yes
data being transmitted.

Transmit System | Decide whether to include the UPC-E System Number in|No

Number the data being transmitted.

Enable UPC-E1 Decide whether to decode both UPC-EO0 and UPC-E1|No
barcodes.

» By default, it decodes the UPC-EO barcodes only.

Enable UPC-E1 Triple|Decide whether to apply read redundancy to the UPC-E1|No
Check barcode.

» When applied, the same UPC-E1 barcode has to be
read three times to make a valid reading. This is
helpful when the barcode is defaced and requires more
attempts to read it successfully.

Addon 2 / Addon 5 Decide whether to decode UPC-E with supplementals. No
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CODE ID TABLE

Code ID Options Set1 Set 2 Set 3 Set 4 Set5
Code 39

Italian Pharmacode
French Pharmacode

Industrial 25

= I O 0O
= 2 X

Interleaved 25
Matrix 25
Codabar
Code 93
Code 128
ISBT 128
UPC-E
EAN-8
EAN-13
UPC-A
MSI
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LR/ELR LASER SCAN ENGINE

The tables below list reader settings as well as symbology settings for the Long Range
Laser (LR) or Extra Long Range Laser (ELR) scan engine.

READER SETTINGS TABLE

LR/ELR Engine

Description

Default

» The scanning won't stop until (@) a barcode is read, (b) the preset

Scan Mode Laser mode
Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.
» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.
Laser Mode Hold down the scan trigger to start with scanning.

timeout expires, or (c) you release the trigger.

Aiming Duration

3 sec.

0~255 (second)

Set the maximum time for decoding to continue during a scan attempt.

> It applies to Aiming mode only.
SYMBOLOGY SETTINGS TABLE
LR/ELR Engine Description Default
Codabar Disable
CLSI Editing When applied, the CLSI editing strips the start/stop|No
characters and inserts a space after the first, fifth, and
tenth characters of a 14-character Codabar barcode.
» The 14-character barcode length does not include
start/stop characters.
NOTIS Editing Decide whether to include the start/stop characters in the [ No
data being transmitted.
» NOTIS Editing is to strip the start/stop characters, i.e.
to disable "Transmit Start/Stop Characters".
Select Length » Any Length Any Length
» One or two fixed lengths
» Range (1~55)
Code 128 Enable
GS1-128 Enable
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Replace Field

Separator

Decide whether to replace the field separator. If the
barcode contains Field Separator “0x1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“0x1D”, it will be changed to %;".

No

ISBT 128

Enable

Industrial 25 (Discrete 25)

Enable

Select Length

» Any Length
> One or two fixed lengths
» Range (1~55)

Any Length

Interleaved 25

Enable

Convert to EAN-13

Convert a 14-character barcode into EAN-13 if the

following requirements are met:

» The barcode must have a leading 0 and a valid EAN-13
check digit.

No

Verify Check Digit

Decide whether to verify the check digit. If desired, select
one of the algorithms below. If the check digit is incorrect,
the barcode will not be accepted.

> No
» USS algorithm
» OPCC algorithm

No

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

> "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).

No

Select Length

» Any Length
One or two fixed lengths
Range (1~55)

Any Length

Code 39

Enable

Convert to Code 32

Convert to Italian Pharmacode.

No

Code 32 Prefix

Prefix character "A" to Code 32 barcodes.

No

Verify Check Digit

Decide whether to verify the check digit. If the check digit
is incorrect, the barcode will not be accepted.

No

Transmit Check Digit

Decide whether to include the check digit in the data being
transmitted.

» "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).

No

Code 39 Full ASCII

Code 39 Full ASCII includes all the alphanumeric and
special characters.

Disable
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Trioptic Code 39

Decide whether to decode Trioptic Code 39.
> Trioptic Code 39 is a variant of Code 39 used in the

marking of computer tape cartridges. It always
contains six characters.
Select Length Any Length Any Length
One or two fixed lengths
» Range (1~55)
Code 93 Disable
Select Length » Any Length Any Length
One or two fixed lengths
Range (1~55)
MSI Disable
Verify Check Digit If Two Check Digits option is selected, an additional|Single Modulo
verification is required to ensure integrity. Select one of|10
the algorithms below. If the check digit is incorrect, the
barcode will not be accepted.
Check Digit Algorithm
One Check Digit Single Modulo 10
Two Check Digits » Mod 10/Mod 11
» Mod 10/Mod 10
Transmit Check Digit Decide whether to include the check digit in the data being | No
transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1~55)
GS1 DataBar (RSS) _—
GS1 DataBar | "Convert to UPC/EAN" only applies to RSS-14 and RSS|Enable
Omnidirectional Limited barcodes not decoded as part of a Composite
(RSS-14) barcode.
GS1 DataBar Limited Enable
(RSS Limited) Convert to EAN-13
(RSS Expanded) » "01" is the Application ID and must be followed by a
Covnert RSS to single zero (the first digit encoded) No
UPC/EAN
Convert to UPC-A
Strip the leading "0100" from barcodes.
> "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the|No

next processing will follow the settings configured for
EAN-13.
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Addon 2 / Addon 5

Refer to UPC/EAN Addon setting.

EAN-13 Enable
Bookland EAN (ISBN) |The EAN-13 barcode starting with 978 will be converted to | No
ISBN.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
UPC-A Enable
Transmit Check Digit Decide whether to include the UPC-A check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-A preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
UPC-EO Enable
Transmit Check Digit Decide whether to include the UPC-EO check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-EOQ preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-EO barcode will be expanded into UPC-A, and the [No
next processing will follow the settings configured for
UPC-A.
UPC-E1 Disable
Transmit Check Digit Decide whether to include the UPC-E1 check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-E1 preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the|No
next processing will follow the settings configured for
UPC-A.
UCC Coupon Extended Code Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and

UPC-A/EAN-128 Coupon Codes.
» UPC-A, EAN-13, and EAN-128 must be enabled first!

UPC/EAN Addon

Addon 2 / Addon 5 Decide whether to decode EAN-8, EAN-13, UPC-EO,|Ignore...
UPC-E1, UPC-A with supplementals.
» Ignore Supplementals
» Decode Only With Supplementals
» Decode With Supplementals (= Auto-discriminate)
Addon Redundancy When "Decode with Supplementals" is applied, decide the|10 times

number of times of supplementary decoding the same
barcode that makes a valid reading.
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CODE ID TABLE

Code ID Options Set1l Set 2 Set3 Set 4 Set5
Codabar F N X N F
Industrial 25 C H H H S
Interleaved 25 D I z I S
Code 39 A C Y M A
Trioptic Code 39 A C Y M X
Code 93 I L L L G
Code 128 H K K K C
Italian Pharmacode A Cc Y M A
MSI \Y \Y D P M
EAN-8 P B B FF E
EAN-13 M A A F E
UPC-A ] A A A E
UPC-E S E C E
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Appendix IV
2D SCAN ENGINE

The tables below list reader settings as well as symbology settings for the 2D scan
engine.

READER SETTINGS TABLE

2D Engine Description Default
Scan Mode Laser mode
Continuous Mode Non-stop scanning

» To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode Non-stop scanning

» Capable of decoding the same barcode repeatedly

Alternate Mode Press the scan trigger to start with scanning.

» The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.

» The scanning won't stop until (a) a barcode is decoded, (b) the pre-set
timeout expires, or (c) you release the trigger.

Laser Mode Hold down the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode Press the scan trigger to start with scanning.

» The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Focus Mode Select the focus mode to control the working range: Far Focus
» Far Focus — optimized to read at its far position
» Near Focus - optimized to read at its near position

» Smart Focus - toggles the focus position after every
frame

Decode Illumination |Decide whether to flash illumination on every barcode|On
capture to aid decoding.

» Turn On (Internal LED)
» Turn Off

Aiming Pattern Decide whether to project the aiming pattern during|On
barcode capture.

» Turn On
» Turn Off

65



MIRROR 5250 Emulator User Guide

Time-out 3 sec.

0~255 (second) Set the maximum time for decoding to continue during a scan attempt.
It applies to the following scan modes only -

» Aiming mode

» Laser mode

» Auto Off mode

Aiming Duration 3 sec.
1~255 (second) Set the maximum time for aiming to continue before a scan attempt.
Picklist Mode Picklist mode enables the decoder to decode only barcodes | Disable
aligned under the center of the laser aiming pattern.
» Enable
» Disable
1D Inverse Decode |1D Inverse Decoder: Decode
» Decode regular 1D barcode only regular 1D
barcode only
» Decode inverse 1D barcode only
» Decode both regular and inverse

Note: (1) Focus Mode is supported on 2D scan engine for 8500 only.
(2) Picklist Mode and 1D Inverse Decoding are supported on 2D scan engine for
8400 only.
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SYMBOLOGY SETTINGS TABLE

1D SYMBOLOGIES
2D Engine Description Default
Codabar Disable
CLSI Editing When applied, the CLSI editing strips the start/stop|No
characters and inserts a space after the first, fifth, and
tenth characters of a 14-character Codabar barcode.
» The 14-character barcode length does not include
start/stop characters.
NOTIS Editing Decide whether to include the start/stop characters in the [ No
data being transmitted.
» NOTIS Editing is to strip the start/stop characters, i.e.
to disable "Transmit Start/Stop Characters".
Select Length » Any Length Any Length
One or two fixed lengths
Range (1~55)
Code 128 Enable
GS1-128 Enable
Replace Field | Decide whether to replace the field separator. If the|No
Separator barcode contains Field Separator “0x1D”, it will be
changed to the desired Field Separator. For example, type
the desired character “;” (semicolon) as the new field
separator. Then if the barcode contains Field Separator
“0x1D”, it will be changed to %;".
ISBT 128 Enable
Industrial 25 (Discrete 25) Enable
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1~55)
Interleaved 25 Enable
Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the|No
following requirements are met:
» The barcode must have a leading 0 and a valid EAN-13
check digit.
Verify Check Digit Decide whether to verify the check digit. If desired, select|No

one of the algorithms below. If the check digit is incorrect,
the barcode will not be accepted.

» No
» USS algorithm
» OPCC algorithm
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Transmit Check Digit Decide whether to include the check digit in the data being | No
transmitted.
> "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).
Select Length » Any Length Any Length
One or two fixed lengths
Range (1~55)
Matrix 25 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
Select Length » Any Length Any Length
> One or two fixed lengths
» Range (1~55)
Chinese 25 Disable

Note: Matrix 25 and Chinese 25 are supported on 2D scan engine for 8400 only.

Code 39 Enable
Convert to Code 32 Convert to Italian Pharmacode. No
Code 32 Prefix Prefix character "A" to Code 32 barcodes. No
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
» "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).
Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and|Disable
special characters.
Trioptic Code 39 Decide whether to decode Trioptic Code 39.
» Trioptic Code 39 is a variant of Code 39 used in the
marking of computer tape cartridges. It always
contains six characters.
Select Length » Any Length Any Length
One or two fixed lengths
Range (1~55)
Code 93 Disable
Select Length > Any Length Any Length

One or two fixed lengths
Range (1~55)
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MSI Disable
Verify Check Digit If Two Check Digits option is selected, an additional|Single Modulo
verification is required to ensure integrity. Select one of |10
the algorithms below. If the check digit is incorrect, the
barcode will not be accepted.
Check Digit Algorithm
One Check Digit Single Modulo 10
Two Check Digits » Mod 10/Mod 11
» Mod 10/Mod 10
Transmit Check Digit Decide whether to include the check digit in the data being|No
transmitted.
Select Length » Any Length Any Length
» One or two fixed lengths
» Range (1~55)
GS1 DataBar (RSS) -—
GS1 DataBar | "Convert to UPC/EAN" only applies to RSS-14 and RSS|Enable
Omnidirectional Limited barcodes not decoded as part of a Composite
(RSS-14) barcode.
GS1 DataBar Limited Enable
(RSS Limited) Convert to EAN-13
GS1 DataBar Expanded || Strip the leading "010" from barcodes. Enable
(RSS Expanded) » "01" is the Application ID and must be followed by a
Covnert RSS to single zero (the first digit encoded) No
UPC/EAN
Convert to UPC-A
Strip the leading "0100" from barcodes.
> "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)
EAN-8 Enable
Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the|No
next processing will follow the settings configured for
EAN-13.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
EAN-13 Enable
Bookland EAN (ISBN) |The EAN-13 barcode starting with 978 will be converted to | No
ISBN.
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
UPC-A Enable
Transmit Check Digit Decide whether to include the UPC-A check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-A preamble System |System
Number (and Country Code) in the data being transmitted. | Number

Addon 2 / Addon 5

Refer to UPC/EAN Addon setting.
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UPC-EO Enable
Transmit Check Digit Decide whether to include the UPC-EQ check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-EO preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-EOQ barcode will be expanded into UPC-A, and the|No
next processing will follow the settings configured for
UPC-A.
UPC-E1 Disable
Transmit Check Digit Decide whether to include the UPC-E1 check digit in the|Yes
data being transmitted.
Transmit Preamble Decide whether to include the UPC-E1 preamble System |System
Number (and Country Code) in the data being transmitted. | Number
Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.
Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the|No
next processing will follow the settings configured for
UPC-A.
UCC Coupon Extended Code Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and

UPC-A/EAN-128 Coupon Codes.
» UPC-A, EAN-13, and EAN-128 must be enabled first!

UPC/EAN Addon

Addon 2 / Addon 5 Decide whether to decode EAN-8, EAN-13, UPC-EO,|Ignore...
UPC-E1, UPC-A with supplementals.
» Ignore Supplementals
> Decode Only With Supplementals
» Decode With Supplementals (= Auto-discriminate)
Addon Redundancy When "Decode with Supplementals" is applied, decide the|10 times
number of times of supplementary decoding the same
barcode that makes a valid reading.
Code 11 Disable
Verify Check Digit Decide whether to verify the check digit. If the check digit|No
is incorrect, the barcode will not be accepted.
» No verification
» One Check Digit
» Two Check Digits
Transmit Check Digit Decide whether to include the check digit in the data being|No

transmitted.

» "Verify Check Digit" must be enabled so that the check
digit can be left out (= "Transmit Check Digit"
disabled).
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Select Length » Any Length Any Length

» One or two fixed lengths

» Range (1~55)
Postal Codes -—=
US Postnet Enable
US Planet Enable
Transmit US Postal [US Postnet or US Planet must be enabled first! Enable
Check Digit
UK Postal Enable
Transmit UK Postal [ UK Postal must be enabled first! Enable
Check Digit
Japan Postal Enable
Australian Postal Enable
Dutch Postal Enable
UPU FICS Postal Disable
USPS 4CB/One Code/ Disable
Intelligent Mail

Note: UPU FICS Postal and USPS 4CB/One Code/ Intelligent Mail are supported on 2D
scan engine for 8400 only.

Composite Codes Disable

Composite CC-C Disable

Composite CC-A/B Disable

Composite TLC-39 Disable

GS1-128 Emulation Transmit UCC/EAN Composite Code data as if it was|Disable

Mode for UCC/EAN encoded in GS1-128 barcodes.

Composite Codes

UPC Composite Mode UPC barcodes can be "linked" with a 2D barcode during|UPC  Always
transmission as if they were one barcode. Linked

UPC Never Linked

barcode is detected.

Transmit UPC barcodes regardless of whether a 2D

UPC Always Linked

transmitted.
» CC-A/B or CC-C must be enabled!

Transmit UPC barcodes and the 2D portion. If the 2D
portion is not detected, the UPC barcode will not be
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Auto-discriminate UPC Composites

Transmit UPC barcodes as well as the 2D portion if
present.
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2D SYMBOLOGIES

2D Engine Description Default

2D Symbologies -—-

PDF417 Enable

MicroPDF417 Disable

Data Matrix Enable

Data Matrix Inverse Decide whether to decode Data Matrix Inverse. Regular Only
Regular Only

Decode regular Data Matrix barcodes only.

Inverse Only

Decode inverse Data Matrix barcodes only.

Inverse Autodetect

Decode both regular and inverse Data Matrix barcodes.

Mirror Image (for Data|Decide whether to decode mirror image Data Matrix|Never
Matrix) barcodes.

Never

Do not decode Data Matrix barcodes that are mirror
images.

Always

Decode only Data Matrix barcodes that are mirror
images.

Auto

Decode both mirrored and unmirrored Data Matrix
barcodes.

Maxicode Enable

QR Code Enable

QR Code Inverse Decide whether to decode QR Code Inverse. Regular Only

Regular Only

Decode regular QR Code only.

Inverse Only

Decode inverse QR Code only.

Inverse Autodetect

Decode both regular and inverse QR Code.
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MicroQR Enable
Aztec Enable
Aztec Inverse Decide whether to decode Aztec Inverse. Regular Only

Regular Only

Decode regular Aztec barcodes only.

Inverse Only

Decode inverse Aztec barcodes only.

Inverse Autodetect

Decode both regular and inverse Aztec barcodes.

Note: Data Matrix Mirror, MicroQR, Aztec, and 2D Inverse are supported on 2D scan
engine for 8400 only.

2D Symbologies - Macro PDF

Macro PDF is a special feature for concatenating multiple PDF barcodes into one file, known as
Macro PDF417 or Macro MicroPDF417.

Transmit/Decode Mode | Decide how to handle Macro PDF decoding. Passthrough
All Symbols
Buffer All Symbols / Transmit Macro PDF When Complete
Transmit all decoded data from an entire Macro PDF
sequence only when the entire sequence is scanned and
decoded. If the decoded data exceeds the limit of 50
symbols, no transmission because the entire sequence
was not scanned!
Transmit Any Symbol in Set / No Particular Order
Transmit data from each Macro PDF symbol as decoded,
regardless of the sequence.
Passthrough All Symbols
Transmit and decode all Macro PDF symbols and
perform no processing. In this mode, the host is
responsible for detecting and parsing the Macro PDF
sequences.
ESC Characters When enabled, it uses the backslash "\" as an Escape|None

character for systems that can process transmissions
containing special data sequences. It will format special
data according to the Global Label Identifier (GLI)
protocol, which only affects the data portion of a Macro
PDF symbol transmission. The Control Header, if enabled,
is always sent with GLI formatting.
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Note: When printing barcodes, keep each Macro PDF sequence separate, as each has a
unique identifier. Do not mix barcodes from several Macro PDF sequences, even if
they encode the same data. When you scan Macro PDF sequences, scan the entire
Macro PDF sequence without interruption!
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CODE ID TABLE

8500
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Code ID Options

Set1

Set 2
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Set 3

Set 4

Set 5

Codabar
Industrial 25
Interleaved 25
Matrix 25
Chinese 25
Code 39
Trioptic Code 39
Code 93

Code 128

ISBT 128
Italian Pharmacode
MSI

EAN-8

EAN-13

UPC-A

UPC-E

Code 11

Composite Code (CC-A/B, CC-C)

Composite TLC-39
US Postnet

US Planet

UK Postal

Japan Postal
Australian Postal

Dutch Postal

USPS 4 CB / One Code / Intelligent Mail

UPU FICS Postal
PDF417
MicroPDF417
Data Matrix
Maxicode

QR Code
MicroQR
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Aztec

IATA

Macro PDF417
Macro MicroPDF417
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